Bearly Bytes
Newsletter
Big Bear Computer Club

Hello Friends,

August 2016 Volume 16 Issue 7

President’s Message - Rosemary Lloyd

Here is a new update
on the workshops sponsored by the Computer Club:
August 15 - Windows 10 Part 2 - Start Menu revisit, Apps, Settings, Customizing, Back Up, Troubleshooting, Windows Updates and Privacy Settings
September 19 - Microsoft Excel - Do the math, charts, graphs and more
October 17 - Settings on your mobile device - Set up and customize your
Android phone or tablet, iPhone or iPad, or Windows phone or tablet
Please contact Rosemary Lloyd to register or ask questions. Email at Rosemary@BigBearCC.org or call 909.547.7257.
We look forward to seeing you at workshops!
Windows 10 users: by the time you read this, Microsoft will have released
the Windows 10 Anniversary Update.

Husband Jim (Left) and
Rosemary Lloyd (Right)

Microsoft Insiders have been testing it since late 2015. After its release on Aug. 2, the Anniversary Update downloads
through Windows Update. You can look for it.
Take care.
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NEXT CLUB MEETING
August 9, 2016
Converting Media to
different Formats
To be held at the
Big Bear Senior Center,
42651 Big Bear Blvd
Big Bear Lake

Microsoft Word Formatting ................................................. 10
GPS Device left in the Sun .................................................. 11
iPhone, iPad and Mac sales are down, but Apple only
cares about services now .................................................... 12
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Word, Excel, & Apple Tips ................................................... 16
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The presenter at this event will be Thomas Brandau,
CEO and owner of Production Recording Media
Company. His company specializes in the archiving and
multi-format transfer of your family memories to current
digital standards. Do you still have VHS family movies of
Christmas and find you can no longer watch them?
Convert them to a convenient digital format. He will
answer your questions after his presentation.

Information & Membership Application ............................ 18
consider bringing a snack to share during break-time
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Microsoft’s Windows 10 New Updating Methods
Resource: http://
www.makeuseof.com/tag/turn-offautomatic-app-updates-windows10/

for Business (CBB). It allows users
to defer updates for an unspecified
amount of time before they are
forced onto the machines. This allows companies to test the security
patches, fixes, and new features
Throughout the entire Technical
before rolling them out
Preview a whole new scheme for
via Windows Server Update Serupdating Windows 10 was used. It vices (WSUS) or other compatible
involved fast and slow rings, which patch management systems such as
controlled how frequently updates System Center Configuration Manwere installed on the participant’s ager, thus allowing more company
devices depending on which ring
control while still making sure all
they belonged to. Now that Winupdates eventually get rolled out.
dows 10 is being sent out into the
wild, update branches (described
And at the bottom of our list we
below) will be used to decide who have Windows 10 Home which usgets updates at what time once they es the Current Branch (CB). It alare available.
lows very little control over updates. The other issue that arises
The most flexibility is with the En- with the Home edition is that Miterprise edition on the Long Term crosoft has decided to apply the
Servicing Branch (LTSB). This is same behavior to all apps installed
only available for customers with a from the Store. A user can initiate
Volume Licensing Agreement
an update check and install cycle,
(VLA) or Software Assurance (SA) but you cannot select what updates
and it allows any update to be post- will be applied. You simply get
poned indefinitely.
them all.
In the middle, we have the Professional, Enterprise, and Education
editions with the Current Branch

www.bigbearcc.org

Editor : HOWEVER… read the
next article in this newsletter (How
to Change Windows Update
Settings When Managed or
Disabled by System Administrator)
to reset how Windows updates are
managed.

NOTICE: from Marc Busch one
of our Computer Club’s expert
computer people.
Marc has been a Microsoft
Windows 10 previewer/debugger.
He has heard the Microsoft is
planning a “massive” upgrade to
Windows 10 with the tentative
starting date of August 2, 2016.
Updates will be done in waves and
not all people will be updated at
the same time.
He expressed some concern about
the update and is advising folks to
back up their system before the
Microsoft update occurs...just

to be safe.
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2016 APCUG International Technology Conference
October 21, 22 & 23, 2016
Palace Station Hotel & Casino, Las Vegas

APCUG at the annual meeting on
Sunday

BE EDUCATED, ENTHUSED AND
ENTERTAINED!

 2016 digital photo, newsletter &
website competition certificates and
prizes awarded on Sunday

The conference is where you can learn
REGISTER FOR
CONFERENCE AT

fee ends October 4
 $100 registration fee
October 5 – October 20
 $125 on-site registration
 Palace Hotel Conference
rate ends October 4, 2016

2016APCUGConf.eventbrite.com
IMPORTANT DATES
 $85 Early Bird registration

HOTEL INFORMATION

Palace Station Hotel & Casino, 2411 W. Sahara Ave, Las Vegas, NV 89102

more about technology from the excellent
speakers, make contacts, share your
thoughts and go home with information for
your tech club. And, don’t forget the food
– it’s great.
Join us for our 2016 Tech Conference and
learn about the ever-changing world of
technology. Whether you are using a
Windows-based or Linux computer, a
Chromebook, Android or Apple device,
this is the conference for you.
You will have the opportunity to attend
presentations on a smorgasbord of social
media sites, iDevices, Android devices,
Windows 10, Linux is like cars, the
Internet of Things…..
Your $85 Early Bird registration
fee covers:



Conference rate code: PCIAPCG

 Conference kick-off presentations



All rooms are equipped with high-speed Internet access.

 Welcome swag bag with sponsor
items, various discounts and special
pricing order forms



Please let them know if you need an ADA-accessible room



Courtyard Rooms: 10/18–10/20 $29.99; 10/21-22 $54.99; 10/23 & 10/24
$29.99



Tower Rooms: 10/18-10/20 $49.99; 10/21-22 $89.99; 10/23 & 10/24 $49.99



A Hotel Service Fee of $9.99 per night will be applied to each guest room
which includes daily newspaper, admission to the exercise facility, and shuttle
service to and from the Strip and McCarran International Airport on a set
schedule.

 Lunch and dinner on Saturday
 Lunch on Sunday
 Your choice of 20+ presentations
 Door Prizes
 Networking with other tech club
officers and members

Call 800 634 3101 to make your hotel reservation

 Up close-and-personal time with
sponsors at the Saturday night Expo
 Find out what is happening with
www.bigbearcc.org
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How to Change Windows Update Settings When Managed
or Disabled by System Administrator
Resource:http://www.askvg.com/how-to- settings to notify you before downchange-windows-update-settings-whenloading and installing the updates
managed-or-disabled-by-systemso that you can select which upadministrator/
dates do you want to install and
NOTE 1: I'm writing this tutorial
when.
specially for Windows 10 but this
If you are using Windows 10 or any
tutorial will also work in all previprevious Windows version and
ous Windows versions.
want to be able to change Windows
NOTE 2: This tutorial was written
for Windows 10 preview builds but
it also works in final RTM version
of Windows 10.

Update settings, this guide will help
you.
Today in this article, we are going
to tell you methods to remove this
restriction and to be able to modify
Windows Update settings as shown
in Figure 2 screenshot.
Continued... Page 5

Imagine a situation when your system administrator or a 3rd party
software or a malware disabled/
restricted Windows Update settings
page. In such situations, you won't
be able to change Windows Update
settings because all available options would be grayed out.
Same thing happened in Windows
10. Microsoft has disabled customization of Windows Update settings
because they want Windows to automatically download and install all
preview updates. Microsoft don't
want testers to modify those settings to prevent them from disabling Automatic Updates.

Figure 1

If you open Windows Update settings page in Windows 10, you get
following screen (Figure 1).
You can see the message "Some
settings are managed by your system administrator" at top and you
can't change settings of automatically download and install Windows updates in the drop-down
box.
Now the problem is that Windows
will automatically download and
install new updates without your
knowledge and you'll have no idea
when and which updates Windows
installed. If you are on a limited
bandwidth or slow Internet connecFigure 2
tion, you may want to change the
www.bigbearcc.org
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Continued… Change Update
We can remove system Administrator restriction from Windows
Update settings using following 2
methods:
METHOD 1: Using Group Policy
Editor (gpedit.msc)

edition users can follow
METHOD 1.
1. Type gpedit.msc in RUN or
Start search box and press Enter.
It'll open Group Policy Editor.
2. Now go to:

Now select any of the given options according to your requirements:


2 - Notify for download and
notify for install



3 - Auto download and notify
for install

Computer Configuration -> Admin
METHOD 2: Using Registry Editor istrative Templates -> Windows
Components
->
Windows
Update
(regedit.exe)

4 - Auto download and schedule the install

3. In right-side pane, look for
 5 - Allow local admin to choose
"Configure Automatic Updates"
setting
METHOD 1: Using Group Policy option (see Figure 3).
See Figure 4.
Editor (gpedit.msc)
4. The option would be set to Not Continued… Page 6
NOTE: Windows 10 Home ediConfigured. Double-click on it and
tion doesn't contain Group Policy
set it to Enabled.
Editor. If you are using Home edition, check out METHOD 2. Other
edition users can follow METHOD
1.
1. Type gpedit.msc in RUN or
Start search box and press Enter.
It'll open Group Policy Editor.
2. Now go to:
Computer Configuration -> Administrative Templates -> Windows
Components -> Windows Update
3. In right-side pane, look for
"Configure Automatic Updates"
option.We can remove system Administrator restriction from Windows Update settings using following 2 methods:

Figure 3

METHOD 1: Using Group Policy
Editor (gpedit.msc)
METHOD 2: Using Registry Editor
(regedit.exe)
So without wasting time lets start
the tutorial:

METHOD 1: Using Group
Policy Editor (gpedit.msc)
NOTE: Windows 10 Home edition doesn't contain Group Policy
Editor. If you are using Home edition, check out METHOD 2. Other
www.bigbearcc.org

Figure 4
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Continued… Change Update
PS: Select the last option "5 - Allow local admin to choose setting"
to be able to choose options in drop
-down box on Windows Update
settings page.
That's it. Apply changes and open
Windows Update settings page.
Now you'll be able to change desired settings.
NOTE for Windows 10 Users:
After applying changes in Group
Policy Editor, open Windows Update page in Settings app. Now
click on "Check for updates" button to force Windows 10 to apply
your changes. After that open Windows Update advanced options and
you'll see the new settings have
been applied successfully.

help of Registry Editor for the same 
task. Just follow these simple steps:

4 (To auto download and schedule the install)

1. Type regedit in RUN or Start
search box and press Enter. It'll
open Registry Editor.

5 (To allow local admin to
choose setting)



PS: Set the value of
AUOptions to 5 to be able to
HKEY_LOCAL_MACHINE\SOF choose options in drop-down box
TWARE\Policies\Microsoft\Windo on Windows Update settings page.
ws
NOTE: If you are using
64-bit edition of Windows, you'll
3. Create a new key under Windows key and set its name also need to follow steps 3-5 for
following Registry key:
as WindowsUpdate
2. Now go to following key:

4. Create another new key under WindowsUpdate key and set
its name as AU

HKEY_LOCAL_MACHINE\SOF
TWARE\Wow6432Node\Policies\
Microsoft\Windows

So the final key path would be:

6. Close Registry Editor and open
HKEY_LOCAL_MACHINE\SOF
Windows Update settings page.
TWARE\Policies\Microsoft\Windo
Now you'll be able to change dews\WindowsUpdate\AU
sired settings.
Further Read: Fixing Windows 10 5. Now select AU key and in rightPS: If you are not familiar with
side pane create a new
Automatic Updates Install
Registry editing tasks, we are also
DWORD AUOptions and set its
Problem.
providing ready-made Registry
value to any of following according
script to do the task automatically.
to your requirements:
Download following ZIP file, ex 2 (To notify for download and
tract it and run .REG file. It'll ask
METHOD 2: Using Registry
notify for install)
for confirmation, accept it. Restart
Editor (regedit.exe)
your computer and Windows will
 3 (To auto download and notify
always notify you before downIf you can't use or don't want to use
for install)
loading new updates:
Group Policy Editor, you can take

www.bigbearcc.org
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Windows 7 is far from being Dead
Resource: Keeping Windows 7 running for the long haul
FIELD NOTES: Tracey Capen
Back in 2010, we wrote about
preparing Windows XP for the
long haul. At that time, Windows
7 was coming online, and many
XP users were reluctant to upgrade. Some things never change.
Fast forward just six years and
Windows 7 is now the "classic" operating system. Fortunately for everyone who's not jumping on Windows 10, Win7 will be around for a
while — here's how to keep it that
way.
Windows 7 is far from a dead
operating system
There are many perfectly good
and legitimate reasons to pass on
Windows 10 and stick with the tried
and true Windows 7. Some users
worry about potential privacy issues
with Microsoft's newest OS; others
have older hardware and software
that can't make the transition. And
many Win7 users simply see no
need to have the hot new thing.
In truth, for most PC users
there's no Windows 10 enhancement, new feature, or looming security threat that makes upgrading a
must-do proposition. Microsoft
won't give Win7 new features, going forward, but the now venerable
OS will get security fixes until Jan.
14, 2020 (assuming you're on Service Pack 1).
Given the millions of systems
currently running Win7, third-party
support shouldn't be an issue anytime soon. New software should run
on the OS and peripherals such as
printers should continue to come
with Win7 drivers. And if you're a
www.bigbearcc.org

hard-core Windows Media Center
user, Windows 10 is not an option.

That generated sufficient blowback that, a couple of months later,
Microsoft posted a list of SkylakeUntil recently, Win10's automat- based systems that would support
ic updating was another reason to
Win7 and Win8.1 — but only until
avoid upgrading — mostly for
July, 17, 2018. (It's highly unlikely
those who prefer to manage that
that these machines will suddenly
task themselves. But Microsoft
stop working on that date, but there
seems intent on moving Win7 up- could be compatibility issues that
dating toward a single, monthly,
arise over time.)
cumulative-patch model. That
change could make updating more
The other concern: There's more
convenient but also more difficult
to PC security than simply adding
to skip specific and possibly troupatches. Some features are built inblesome patches.
to the operating system and can't be
back-ported to an older OS. (This
There are really only a couple of was and still is a huge issue with
possible problems with sticking to Windows XP.) So, over time, Win7
Win7. First, if you buy new hardwill fall further and further behind
ware with the latest chip sets, you
Win10 in its ability to ward off
might not be able to wipe the facto- cyber attacks.
ry-installed version of Win10 and
migrate your Win7 setup to the new
With that said, here's our guide
machine.
to keeping Windows 7 running for
the next few years, based on some
This past January, there were
of our most popular articles. Use
numerous articles stating that Intel's this as a quick reference for key
new Skylake processor would only Windows 7 topics.
work with Windows 10. Microsoft
had no plans to update either Win7 Continued… Page 8
or Win8.1 to support the new processors.
7

Continued… Windows 7
Keep Win7 systems backed up
and your data safe

For basic instructions on using
Win7's built-in backup tools, see:
"Build a complete Windows 7
safety net" – May 12, 2011,
Top Story

The time to think about a backup
strategy isn't, obviously, after something goes seriously wrong. Unfor- "How to safely test file and image
tunately, many of us have learned
backups" – April 16, 2015,
the hard way that our backup sysTop Story
tems were lacking or faulty.
Win7's built-in tools are fine for
most standalone setups, but if
you're using a network-attached
storage or backing up multiple systems, you might want to consider
third-party alternatives such as
Macrium Reflect (site) or Acronis
True Image (site). Not only are
these apps more powerful than
Windows' backup/rescue/recovery
tools, they're also more flexible —
you can, for example, pull individuYes, good backups are important al files from an image backup.
for all systems. But with diminishing support for Win7 and the rapid
rise of ransomware attacks, it's especially critical for Win7 users.
Here's what you need to know:
Not only do you want to make
sure you're creating backups, you
need to thoroughly test them to ensure you can do both partial and full
recoveries. In our past stories,
we've given an example of a backup
system went offline without any
obvious indication; and another instance where a failure took out both
the internal system drive and the
external backup drive.

www.bigbearcc.org
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Big Bear Computer Club News

You Can Help
Out the Big Bear
Computer Club
and at NO COST TO
YOU
By using AmazonSmile!
Big Bear Computer Club
Board Notification
The Computer Club Board is looking a new board member.
The “new” Board of Directors
Position -- which is a position that
has been filled in the past but
within the last couple of years the
position became vacated and not
re-occupied. This board position is
for a person that can make
resurrection efforts to recruit
website and newsletter business
advertisers.

2016 Big Bear
Computer Club
Workshops
All workshops are 1:00-3:30pm
and being held at the Senior
Center. Each workshop costs $15.
August 15, 2016 – Windows 10
Part 2
September 19, 2016 - Microsoft
Excel
October 17, 2016 – Settings on
your mobile device

Board News
Computer Club Bylaws and Rules
and Regulations are now available
to be read on our Computer Club
website. Soon our Board Minutes
along with the club’s finance
report will be posted.

www.bigbearcc.org

To Register Contact:
Rosemary Lloyd 909.547.7257
rosemary@sugarloafpc.com

The next time you online shop
at Amazon, just go up to the
address
bar
and
enter
smile.amazon.com from the
web browser on your computer
or mobile device.
For each
AmazonSmile purchase you
make, Amazon will donate
0.5% of your purchase price to
the Big Bear Computer Club.
For the computer club to receive the donations, you need to
select the Big Bear Computer
Club as the non-profit organization of choice to receive your
purchase donations.
If you have not signed up for
Amazon Smile. Click on the
Get Started button above.
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Microsoft Word Formatting

Tips to Compare Edited Word Files
Use Compare to automatically compare changes between/among edited files.
1. With original file open, Review Tab > Compare
2. Browse to locate and open edited file.
3. Review Pane displays.
4. Changes will appear in balloons.
5. Click check box to accept.

Tips to use the Ruler to Set or Change Tabs
1.
2.
3.
4.

View > Ruler.
Click in text (or select text) where you want tab set.
Show tab in the tab box on the ruler.
Click the mouse on the lower half of the ruler where you want the tab set.

5. See Page Layout Tab > Paragraph command group > Launcher button > Tab button for full dialog
tab commands. You can also double-click on a tab. The default setting can be changed at this
location.
Deleting a Tab
1. Select text.
2. Drag the tab marker icon off the ruler,
and drop it.
Moving a Tab
1. Select text.
2. Drag the tab marker to the new position
on the ruler. Clear All Tabs.
3. Select text.
4. Double-click on a tab to view the Tab
dialog.
5. Click the Clear or Clear All button.
Creating Tab Leaders
1. Select text.
2. Format > Tabs.
3. Click on tab set on ruler you want the leaders to lead up to.
4. Click on the type of leader.
5. Click on OK
www.bigbearcc.org
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GPS Device left in the Sun

This is true according to “Truth or Fiction.” There is very little spacing between the anode and the cathode in a
lithium battery and the liquid in between is highly volatile and flammable. You should not leave cell phones,
computers, etc in a hot car or store any of these items together wrapped up in a blanket and left in direct
sunlight. Do not destroy one of these batteries with a hammer. The anode will touch the cathode causing a
short. . BOOM!
You think this may be the reason why the US Postal Service will no longer ship electronic devices that contain
lithium batteries?

GPS was placed in its bracket on the windshield and left in the sun.
The battery overheated and exploded !

www.bigbearcc.org
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iPhone, iPad and Mac sales are down, but Apple only cares about services now
Resource:
https://techcrunch.com/2016/07/26/iphoneipad-and-mac-sales-are-down-but-appleonly-cares-about-services-now/
by Romain Dillet (@romaindillet)

Apple just reported its Q3 2016
earnings, and investors are sending
its stock through the roof. While the
company managed to beat analysts’
expectations, Apple is selling fewer
iPhones, iPads and Macs than last
year during the same period. The
long period of endless growth on all from this device while selling less
units. Both the 9.7-inch and 12.9product lines is definitely over.
inch iPad Pro models are more exIn particular, Apple reported 40.4
pensive than last year’s iPad Air 2.
million iPhone sales compared to

Apple is already a service company.
But there’s nothing remarkable
right now about Apple’s services.
But it looks like the company is investing a lot on services as we can
47.5 million last year — that’s
And yet, the company wants you to see with the Apple Music redesign
down 15 percent. Mac sales are also
look the other way. As you can see happening just a year after the
down from 4.8 million units to 4.3
in the earnings release, the compa- launch, or the App Store changes.
million (-10.5 percent). And even
ny can’t stop raving about its seriPad sales, despite a huge iPad Pro
vices. Apple Music, the App Store,
update, are still going down — 10
Apple Pay and iCloud are starting
million vs. 10.9 million last year (to generate quite a lot of money.
8.3 percent).
“Our Services business grew 19
percent year-over-year and App
Store revenue was the highest ever,
as our installed base continued to
grow and transacting customers hit
an all-time record,” Apple’s CFO
Luca Maestri wrote in the release.
Surprisingly, margins are all over
the place. The company’s overall
gross margin is down quite a lot
from 39.7 percent to 38 percent.
That’s most likely due to the release
of the iPhone SE. Selling a cheaper
phone with the components of the
iPhone 6s could only hurt the company’s margins.
The iPad is an exception as Apple
is now generating more money
www.bigbearcc.org

Even on the earnings call Tim Cook
mentioned services saying that “we
expect it to be the size of a Fortune
100 company next year.”
Apple is also spending a lot of
money on research & development.
This quarter alone, Apple reported But as the name suggests, it’s hard$6 billion in services revenue — up er to tell what the company is cur19 percent year-over-year. Apple
rently building. So services is not
has been branding itself as a service only a good diversion from sales
company for a few months. But ser- numbers, but also a diversion from
vices at Apple is nothing new —
these jumping research & develop.Mac, MobileMe, iCloud… iTunes, ment costs.
Apple Music, App Store, Maps…
12

Apple TV for more TV Viewing Options
By Jim Cerny, Columnist, Sarasota
TUG, FL

search for movies, TV shows, or any
other videos available through the
internet. If you are looking for a
April 2016 issue, Sarasota Technology particular movie, the Apple TV will
Monitor
find it and show you which of your
apps has that movie available to you
www.thestug.org / jimcerny123 (at)
or, of course, you may also watch it
gmail.com
through iTunes, probably for a charge.
You can even download some relaxing
The Apple TV is a neat little box
videos such as a fireplace or aquarium
device you plug into a power outlet
just for atmosphere.
and into the back of your TV for a
whole lot of fun TV viewing options. Music apps, such as the free Pandora,
The latest version of Apple TV is
Spotify and others, will open up a

devices using your iTunes or Apple ID
account.
Another fun ability of the Apple TV is
to duplicate your display screen of
your iPad and iPhone on your big
screen TV. This comes in very handy
for teaching my iPad class.

The set-up of the Apple TV out of the
box is not difficult and will step you
through the process. It comes with a
whole world of music nice remote control which you “swipe”
options for your lis- and “click” with your finger to
navigate through the settings and
tening enjoyment.
options. Please be prepared to “Ask
You can “like” or
Google” if you have any questions
“not like” whatever
music you are listen- about the set-up. As I mentioned
earlier, you will need to purchase an
ing to and Pandora,
HDMI cable to connect it to your TV.
for example, will
bring you more music You may not want to consider
you like based upon purchasing an Apple TV unless you
also have at least one other Apple
your choices. You
device, such as an iPhone or an iPad.
can also make up
playlists of your
favorites by genre
(classical, jazz, coun- The Apple TV also comes with “Siri”
called the “Fourth Generation” which, try, etc.) and pick your playlist to
– the voice recognition capability. This
of course, has more possibilities and
match your mood.
eliminates having to use the controller
options than the previous versions. If
to key-in one letter at a time to do a
you are an Apple user of other devices,
search – just hold down the microsuch as an iPad and/or an iPhone, the
Apple TV could be a really fun addiGames are an option too. There a many phone button on the controller and ask
tion to your Apple family. It is in the
apps that will allow you to play games it anything. Of course the Apple TV is
price range of $150 to $200 depending on your TV through the Apple TV box capable of more uses than these (and
and more games are on the way. Apple more are coming) but they do give you
upon the memory size.
a good idea to help you decide if an
is looking to compete with the big
gamers by providing some game con- Apple TV would be good for you.
What does it do? When you connect
your Apple TV to your television set or
computer monitor (you will need an
HDMI cable to connect it which does
not come with it) you will be prompted
to connect it to your other Apple
device(s) and your WIFI home
network. When this happens, the
following options or abilities would be
available to you:

trollers for the Apple TV in the near
future.

Overall, I think it is a very nice device
with many possibilities. But I also
Photographs are fun and are even easi- caution that it is not for everyone. If
er to share and show on your TV. You you are interested, ask your friends or
someone at your computer users group
can set your iPhone or iPad to save
who has one, and “Ask Google” too,
your photos to the cloud and this
you will learn more of the possibilities.
makes your photos available to view
Like many devices, different people
using your Apple TV. Remember the
use it for different reasons. Maybe it
“cloud” is a way of saving your stuff
would be something you would enjoy.
on the internet so that it can be
available to your other devices which It certainly is a big step closer to
Download Apps (you know, programs can also access the internet. Being an
“cutting the cable” to your video
and things) such as Netflix, Hulu, and Apple product, naturally it works the
provider and saving a bunch of money
YouTube (which are free) and you can best and easiest with your other Apple every month!
www.bigbearcc.org
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About Bearly Bytes
Bearly Bytes Newsletter, past winner of SWUGC &
APCUG Newsletter contests. is the official
publication of the Big Bear Computer Club. Views
expressed in Bearly Bytes are those of the authors
and do not necessarily reflect the opinions of Big
Bear Computer Club. Other computer user groups are
welcome to reprint our articles as long as they give
credit to the author and Bearly Bytes, Big Bear
Computer Club.
Submissions: All BBCC members are encouraged to
send letters, articles, questions, and comments to
Bearly Bytes for inclusion in future issues. Submit as
plain text in the body of an email
and attach any graphics as JPEG or
GIF format.

Bits & Bytes
July 2016 Club Meeting
The Club meeting celebrated Christmas in July with
turkey, ham, and all of the trimmings. Everyone
received one or more gifts. No business and no
presentations were provided. Just party. We were
surprised by the low turnout! The first time in all of
the years of doing Christmas in July.
Attendees

Send to Yomar Cleary –
ycleary@charter.net

Enter "Find the Bear"
contest to win a cool prize
1.
2.
3.
4.

Locate this "BEAR"
Click on it
Fill in the form
and then Send

Must attend the following meeting
to receive the prize
www.bigbearcc.org
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Monthly Calendar

Your Computer Club donation is
tax deductible.
Donations are accepted though Paypal.

You do not need a Paypal account to
donate through Paypal.

Group Newsletter Sites

www.bigbearcc.org
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Word Tips

By Rosemary Lloyd

Choose a Template
in Word 2013
It’s often easier to create a new
document using a template instead
of starting with a blank page.
Word templates are ready to use
with themes and styles. All you
need to do is add your content.
Each time you start Word 2013,
you can choose a template from
the gallery, click a category to see
the templates it contains, or search
for more templates online. (If
you’d rather not use a template,
just click the Blank document.)
https://support.office.com/en-us/article/
Basic-tasks-in-Word-2013-87b3243cb0bf-4a29-82aa-09a681999fdc

www.bigbearcc.org

Excel Tips

Apple Tips

Printing Multiple Selections

Four iPhone Tips

1. Create a new worksheet to be
used for consolidation/printing.
2. Select the range on the
worksheet that you wish to print.
3. Press Ctrl+C to copy the
selection.
4. Go to the new sheet and select
the cell where you want the
information to appear.
5. Display the Home tab of the
ribbon.
6. Click the drop-down arrow
under the Paste tool (left side of the
ribbon) and then choose Paste
Special. Excel displays the Paste
Special dialog box
7. Click on Paste Link. The dialog
box disappears and the linked information appears in the worksheet.
8. Repeat steps 2 through 7 for any
other ranges you want included on
the printout.
Print the worksheet with the consolidated information.

1. There is an iPhone undo
function that allows you to go
back if you make a mistake
writing a text message, email, or
editing a photo. Simply shake

The one big drawback to this approach is that if the worksheets from
which you are copying have radically different formatting, you may not
be able to merge them into a consolidated worksheet satisfactorily. (You
will need to adjust the formatting in
the consolidation sheet after pasting
the different ranges.) In this case
you may need to adjust formatting to
get exactly the effect you desire.
ExcelTips is your source for costeffective Microsoft Excel training.
This tip (12204) applies to Microsoft
Excel 2007, 2010, 2013, and 2016.
You can find a version of this tip for
the older menu interface of Excel
here: Printing Multiple Selections.

2. Double-tapping the spacebar
will automatically end the sentence with a period and start a
new one for you.

By Yomar Cleary

your phone and this option will
pop up.

3. You can teach Siri how to
properly pronounce words by
saying, "That's not how you
pronounce______," and she will
then give alternatives for you to
choose the correct one.
4. You can see the timestamps of
your text messages by sliding
your texts over to the left.
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Helpline
The following members have
generously offered to help you with your PC
problems by phone or by email:
Windows Beginners .................Yomar Cleary
909.214.6990
ycleary@charter.net
Microsoft Windows ............. Rosemary Lloyd
909.547.7257
Rosemary@bigbearcc.org
MS Outlook .......................... Rosemary Lloyd
909.547.7257
Rosemary@bigbearcc.org

Officers and Key Leaders
President ................................ Rosemary Lloyd
909.547.7257
rosemary@sugarloafpc.com
Vice President ..……………....….Yomar Cleary
909.214.6990
ycleary@charter.net
Treasurer .................................. Barbara Moore
909.585.7981
barbmoorebbl@gmail.com
Secretary ..................................... Sandi Ybarra
909.585.8318
sandiscabin@gmail.com
Director at Large …...…....……… Jerry Merino
909.585.8714
gmerino@charter.net

MS Excel ................................... Yomar Cleary
909.878.5622
ycleary@charter.net

Director at Large .……….…......... Marc Busch
949.609.9266 ………....bigbearjedi@charter.net

MS Publisher ........................... Yomar Cleary
909.214.6990
ycleary@charter.net

Director at Large .………...…......... Bill Bryant
808.903.7918…..graphicelements@icloud.com

Digital Photos ........................ Barbara Moore
909.585.7981
barbmoorebbl@gmail.com
CD Burning .......................... Rosemary Lloyd
909.547.7257
rosemary@bigbearcc.org
Computer Upgrades................... Marc Busch
949.609.9266
bigbearjedi@charter.net
The Computer Club provides training at
the monthly meetings when there is no
presenter.
Persons with all levels of computer
knowledge are welcome to attend the
club’s open meetings.

Your First 2 visits are free!
Bring a friend.

Annual Membership is $25 and spouse $5.
All recurring membership dues are due in
January.

Webmaster .................................. Bill Flanagan
909.866.9379
bill@bigbearcc.org
Newsletter Editor ....................... Bill Treadwell
909.730.4625
treadwell@bigbearcc.org
Publicity ......................................Yomar Cleary
909.214.6990
ycleary@charter.net
Equipment Chair ......................... Don Odekirk
909.585.6728
BigBearOdie@yahoo.com
Technical Advisor … ....................... Jim Lloyd
909.584.9358
inquiries@sugarloafpc.com
Refreshments Chair ……..…… Sharon Teeter
909.585.2026
sharonteeter1@verizon.net
Membership Chair …………. Barbara Moore
909.585.7981
barbmoorebbl@gmail.com
Historian ......................................Sandi Ybarra
909.585.8318
sandiscabin@gmail.com
Sunshine Chair .......................... Angie Pezina
909.866.2314…..
apezina@gmail.com

THE BEAR WANTS YOU
TO SHARE A TIP
Send tips to Yomar Cleary –
ycleary@charter.net

www.bigbearcc.org

Name Tags/Hospitality……...……Dorothy Sirk
909.585.3449
dorothymsirk@hotmail.com
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General Information and Membership
BIG BEAR COMPUTER CLUB

Membership Benefits

A Non-profit 501(c)(3) corporation

Membership Application

 Monthly Meeting presentation and demonstration
of popular hardware and
software

□New □ Renewal

□ Update Information

 RAM (Q&A) sessions

Full Name

 Tech News and Virus
Alerts

Mailing Address _______________________________________________________________

 Door prize drawings

City, State, Zip ________________________________________________________________

 Bearly Bytes, our awardwinning monthly newsletter emailed

Home Phone _(______)___________________

 Website: bigbearcc.org
 Free Software Review

___________________________________________________________________

Cell Phone_(_____)__________________

E-mail address ________________________________________________________________
Adding Associates
For each Family Member (s) add $5/year towards your dues.

 Member Help Line
 Member E-mail Notifications

Name_________________________ _____________E-mail____________________________

 Member-only Discounts

1. Mail your application and a $25 check for dues to:
BBCC Treasurer
PO Box 645
Big Bear City, CA 92314
OR
2. Bring your application and dues to a meeting
OR
3. PayPal click here

 Training workshops
All this for only
$25 per year!!

For additional information
You can contact
Rosemary Lloyd, President
909.547.7257

Bearly Bytes Newsletter
Big Bear Computer Club
PO Box 645
Big Bear City, CA 92314

www.bigbearcc.org
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